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Thermochemical Data of Selected Elements and Compounds  
(at 25 C̄ and 100.000 kPa)1 
 

Substance 

DH f  ̄

(kJ/mol) 

S̄  

(J/K mol) 

DGf  ̄

(kJ/mol) 

  

Substance 
DH f  ̄

(kJ/mol) 

S̄  

(J/K mol) 

DGf  ̄

(kJ/mol) 

Al (s) 0 28.3 0  NH3 (g) -46.1 192.5 -16.5 

Al2O3 (s) -1675.7 50.9 -1582.3  N2H4 (l)  50.6 121.2 149.3 

Br2 (l)  0 151.6 0  NH4Cl (s) -314.4 94.6 -202.9 

HBr (g) -36.4 198.7 -53.5  NH4NO3 (s) -365.6 151.1 -183.9 

Ca (s) 0 41.4 0  NO (g) 90.3 210.8 86.6 

CaCO3 (s) (calcite) -1206.9 92.9 -1128.8  NO2 (g) 33.2 240.1 51.3 

CaCl2 (s) -795.8 104.6 -748.1  N2O (g) 82.1 219.9 104.2 

C (s) (graphite) 0 5.7 0  N2O4 (g) 9.2 304.3 97.9 

C (s) (diamond) 1.9 2.38 2.90  HNO3 (l)  -174.1 155.6 -80.7 

CCl4 (l)  -135.4 216.4 -65.2  O (g) 249.2 161.1 231.7 

CCl4 (g) -96.0 309.9 -60.6  O2 (g) 0 205.1 0 

CHCl3 (l)  -134.5 201.7 -73.7  O3 (g) 142.7 238.9 163.2 

CH4 (g) -74.8 186.3 -50.7  P4 (s) (white) 0 164.4 0 

C2H2 (g) 226.7 200.9 209.2  P4 (s) (red) -70.4 91.2 -48.4 

C2H4 (g) 52.3 219.6 68.2  PH3 (g) 5.4 310.2 13.4 

C2H6 (g) -84.7 229.6 -32.8  PCl3 (g) -287.0 311.8 -267.8 

C3H8 (g) -103.8 269.9 -23.5  P4O6 (s) -2144.3 345.6 -2247.4 

C6H6 (l)  49.0 172.8 124.5  P4O10 (s) -2984.0 228.9 -2697.7 

CH3OH (l)  -238.7 126.8 -166.3  H3PO4 (s) -1279.0 110.5 -1119.1 

C2H5OH (l)  -277.7 160.7 -178.8  K (s) 0 64.2 0 

CH3CO2H (l)  -484.5 159.8 -389.9  KCl (s) -436.7 82.6 -409.1 

CO (g) -110.5 197.7 -137.2  KClO3 (s) -397.7 143.1 -296.3 

CO2 (g) -393.5 213.7 -394.4  KOH (s) -428.8 78.9 -379.1 

COCl2 (g) -218.8 283.5 -204.6  Ag (s) 0 42.6 0 

CS2 (g) +117.4 237.8 67.1  AgCl (s) -127.1 96.2 -109.8 

Cl2 (g) 0 223.1 0  AgNO3 (s) -124.4 140.9 -33.4 

HCl g) -92.3 186.9 -95.3  Na (s) 0 51.2 0 

Cr (s) 0 23.8 0  NaCl (s) -411.2 72.1 -384.1 

CrCl3 (s) -556.5 123.0 -486.1  NaOH (s) -425.6 64.5 -379.5 

Cu (s) 0 33.2 0  Na2CO3 (s) -1130.7 135.0 -1044.0 

CuO (s) -157.3 42.6 -129.7  S (s) (rhombic) 0 31.8 0 

CuCl -137.2 86.2 -119.9  S (g) 278.8 167.8 238.3 

CuCl2 (s) -220.1 108.1 -175.7  SF6 (g) -1209.0 291.8 -1105.3 

F2 (g) 0 202.8 0  H2S (g) -20.6 205.8 -33.6 

HF (g) -271.1 173.8 -273.2  SO2 (g) -296.8 248.2 -300.2 

H2 (g) 0 130.7 0  SO3 (g) -395.7 256.8 -371.1 

H2O (l)  -285.8 69.9 -237.1  H2SO4 (l)  -814.0 156.9 -690.0 

H2O (g) -241.8 188.8 -228.6  Sn (s) (white) 0 51.6 0 

H2O2 (l)  -187.8 109.6 -120.4  Sn (s) (gray) -2.1 44.1 0.1 

Fe (s) 0 27.8 0  SnCl2 (s) -325.1 122.6 -302.1 

FeO (s) -272.0 57.6 245.1  SnCl4 (l)  -155.3 258.6 -440.1 

Fe2O3 (s) -824.2 87.4 -742.2      

Fe3O4 (s) -1118.4 146.4 -1015.4     

FeCl2 (s) -341.8 118.0 -302.3     

FeCl3 (s) -399.5 142.3 -344.0     

FeS2 (s) -178.2 52.9 -166.9     

Pb (s) 0 64.8 0     

PbCl2 (s) -359.4 136.0 -314.1     

Mg (s) 0 32.7 0     

MgCl2 (s) -641.3 89.6 -591.8     

MgO (s) -601.7 26.9 -569.4     

N2 (g) 0 191.6 0     

                                                 
1
 This table was reprinted with permission from Peggy Lawson, Oxbow Prairie Heights School. A copy of this table can be 

obtained from http://www.saskschools.ca/curr_content/chem30_05/appendix/tables_charts/thermochemical_data.pdf 
(Accessed 9-01-2008). 

http://www.saskschools.ca/curr_content/chem30_05/appendix/tables_charts/thermochemical_data.pdf
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Common Laboratory Glassware 
 

 
 

Continued on the next page 
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Common Laboratory Glassware, continued 
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Laboratory Safety Rules 
 

1. Follow directions precisely and completely. 
 The directions have been carefully designed to avoid accidents.  Your 

instructor will point out hazards before you begin so pay attention! 
 
2. Safety Goggles 
 Goggles with side splash guards are required by law and are available at the 

college bookstore. Safety glasses are not permitted. 
 
3. Clothing/Long Hair 
 Students must wear proper clothing in the laboratory.  Sandals and shorts 

should not be worn on lab days.  Long hair should be tied up in a band. 
Wear OLD clothing in the laboratory.  

 
4.   Place bags, purses, coats, etcé on the shelves near the door.  
 
5. Never smoke or eat in the laboratory. No food is allowed in lab. 
 
6. Use waste containers provided by your instructor. 
 Make sure you read the labels on waste containers and notify the instructor 

when the containers are full. 
 
7.  Excess chemicals should never be returned to the reagent 

containers. 
 The entire supply might become contaminated.  Instead, give your excess 

to other students or put them in the waste containers. 
 
8.   Broken Glass 
 Dispose of broken glass in the blue and white cardboard boxes provided in 

the laboratory.  Do not place broken glass into the trash can. Use a 
dustpan and brush provided—do not use your fingers to pick up the glass. 

 
9.   Know the location and the use of the first aid kit, fire 

extinguishers, the emergency shower and the eye wash in case of 
emergencies. 

 
10. Keep the benchtop clean and dry at all times. Clean with soap and 

water at the end of the period. 
 
 

Continued on the next page 
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11. Do not look down into a test tube! Angle test tubes away from 

people as you heat them. 
 Keep your face away from any chemicals being heated in open apparatuses.  

The tubes may erupt like geysers, so point them away from people. 
 
12.    Sniff!! Do not inhale!! 
 When attempting to detect chemical odors, sniff gently.  Most chemical 

vapors are at least irritating if not toxic. 
 
13. Do not pick up hot objects. 
 Let items cool or use oven mitts/tongs to move hot items. 
 
14. Always pour concentrated acids into water carefully. 
 Any concentrated reagent should be handled with care.  Always pour 

concentrated sulfuric acid into water down the side of the container.  Never 
pour water into concentrated sulfuric acid. 

 
15. Wash it off with water! 
 If any chemical is splashed on you, wash it off with PLENTY of water.  Then 

report to the instructor, if further treatment is needed. 
 
16.    Always wash your hands before leaving lab. 
 
17. Mercury vapors are poisonous 
 If some mercury is spilled (like by breaking a thermometer), it must be 

picked up immediately and properly disposed of.  Notify the instructor. 
 
18. Do not perform unauthorized experiments. 
 One of the common sources of accidents is the performance of experiments 

that have not been explicitly assigned or approved by the instructor. 
 
19. When in doubt, ask your instructor. 
 Your instructor is in the laboratory to answer any questions that come up in 

the course of the quarter's work. 
 
20. Emergency  
 In case of an accident, notify your instructor immediately.   
 
 The phone number for security is 425-564-2400   

(Extension 2400 from any campus phone.) 
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Laboratory  Safety  Worksheet    Name__________________ 
        

1. Sketch the floor plan of the laboratory .  Indicate the locations of exits, 

eyewash, ventilation hoods, fire extinguisher, first aid kit, and safety shower. 

 

 

 

 

 

 

 

2. What are the laboratory rules about safety goggles?  

 

 

3. If you take too much of a chemical when working, what are you supposed to 

do with the excess? 

 

 

4. Should you pick up broken glass with your fingers?  Does the broken glass 

go in the trash can?  If not, where does it go? 

 

 

5.     What precautions should be taken to prevent staining or damaging your 

clothing in the laboratory? 

 

 

6. What is the correct way to dispose of chemicals at the end of the laboratory 

period? 
          
 
7.      Why should you wash your hands before leaving lab? 
 
 
 
I have read and will comply with all stated laboratory safety rules. 

 

Signature ____________________    Section ______     Date _______
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How to record data 
 

A very important part of science relies on the ability of scientists to reproduce their 
results.  Thus it is required that scientists maintain complete and accurate records of 
their work.  This includes every piece of data (with units!), sketches of equipment or 
apparatuses used, and observations during the experiments. 
 
Each instructor may require a different set of rules regarding your lab work (some may 
require a lab notebook be kept; others may require that you submit a lab report at the 
completion of an experiment).   
 
The following is a list of recommendations for recording information during an 
experiment into the lab handouts.  The handouts were designed to mimic some of the 
components of a lab notebook.  Although the advantage of a permanently bound 
notebook is lost, the right-hand column in each Procedure section is left nearly blank for 
students to record data and observations in the same manner it would be done in a 
bound lab notebook.   
 
Make sure you record: 
 
1. Your name and your lab partner’s name on every page. 
2.  Date of the experiment  
3.  Data table or list of data 
4.  Observations  
5.  Record of the time may help in some cases, such as at the beginning and end of a 
waiting period 
 
Guidelines for recording all data and observations: 
 
Use a ballpoint pen (permanent ink).  Papers often get wet and data is easily lost if the 
ink washes away.  If you make a mistake, do not use white out.  Instead, draw a neat 
line through the word(s) so they remain legible.  Do not use pencil because it is easy to 
erase (and lose) data that you may later wish to recover. 
 
Record all measurements to an appropriate number of significant figures, as based on 
your measurement device. 
 
Record the units on every measurement!  The units may seem obvious to you, but you 
must not leave any ambiguities.  
 
Important observations and notes (such as chemical changes, or changes to the 
procedure) should be recorded clearly and concisely.  
 
Never record data on scratch paper or any other piece of paper that requires the data to 
be transferred to the handout.  Record all data directly onto the handout.   
 

General rule of thumb:  Always write and organize your work so someone else 
will be able to repeat your directions without any confusion or uncertainty. 
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Organizing your data:  Creating data tables 
Advance preparation and understanding of the lab is important in knowing what data to 
collect.  Remember to keep in mind that when you weigh a substance, you may not tare 
the mass of the container.  Taring the container means that you set the container on the 
balance and ―zero‖ it.  This means the balance will automatically subtract the mass of 
the container in its reading(s).  Instead, you will need to record a mass for the 
container, the mass of the substance in the container, and determine the mass of the 
substance by mass difference. Thinking ahead about these details will help you 
construct a data table. 
 
 
 
 
 
 
In the table above, the student provided a clear description for each measurement, 
along with the units next to each number.  The data above was filled in during lab.  
There are two entries in the data table without any values assigned.  These entries were 
included by the student, who determined that these values would need to be calculated 
at a later stage in this particular experiment.  Can you fill in the blanks based on the 
data recorded? 
 
Keep in mind that the data table should be organized in a logical way.  It would be 
confusing to put the density of the unknown liquid in the table first, since it requires the 
mass and volume of the unknown liquid.  Following a logical order will minimize 
confusion, especially for your instructor! 
 

How to record observations 
Observations are so important to the scientific method that we’ve even included a lab 
this quarter just to illustrate the point!  (See Activity 1 on Legos) 
 
Make sure you record what you see initially and whatever changes that may occur.  
Especially of importance are chemical changes, such as color changes or the formation 
of a gas or solid.  It is also a good idea to make drawings or sketches of a setup or an 
apparatus with which you are not familiar.  You should also record notes about your 
progress and whether you’ve made any modifications to the experiment.   
 
Consider your observations to be notes that you are taking during your experiment—
notes that may be very useful for you in repeating your experiment or in gaining 
understanding about the experiment. 

 
Signing and dating your data 
At the end of lab you will be asked to sign and date your data sheets.  This verifies 
when the experiment was carried out.  Your signature is your word that the data you 
present are obtained in an honest fashion and to the best of your ability.  As a scientist, 
you are held accountable for the data and conclusions that you communicate to others. 

mass of 10-mL graduated cylinder (empty) 25.067-g 

mass of 10-mL graduated cylinder + unknown liquid 28.076-g 

mass of unknown liquid  

volume of unknown liquid 5.80-mL 

density of unknown liquid  
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Name__________________________     Section_______ 

 

Questions:  How to record and organize your data 
 
1)  Why is it important to use pen to record your data? What is the appropriate method for 

correcting mistakes? (Can you use white-out?) 
 

 
 

 

 
 

 
 

 
2)  Why should you label your measurements with units? 

 

 
 

 
3)   Suppose you are doing an experiment which requires that you mix each reagent A, B, and C 

with reagents 1, 2, and 3 for a total of nine experiments.  Construct a condensed and concise 

data table for these set of experiments. 
 

 
 

 

 
 

 
 

 
 

 

 
4)  Suppose you wish to measure the density of water.  a)  In a few sentences, describe how you 

would do this (in other words, provide a short procedure).  b) Without carrying out the 
experiments, construct a hypothetical data table that you might use to accompany your 

procedure.  Remember, you need to have a place to record ALL of your data, even if it is not 

directly used in the density calculation. (See data table on the previous page.) 
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Activity 1   
Observations, the Scientific Method, and Legos 
Adapted from: Journal of Chemical Education; Vol. 78 No. 9 September 2001. 
 
 
Purpose 
 

You may be wondering what these three 
things (Observations, the Scientific Method, 

and Legos) have in common.  This lab 
exercise will highlight some important 

aspects of science and the scientific method 

using Lego building blocks (Lego is a 
registered trademark of The Lego Group).   

  
 

Background 

 
Definitions 

 
First we will start with some definitions.  

Defining the words we use is necessary so 
that we have a common understanding of 

what we are discussing.  Defining the terms 

we use allows us to avoid ambiguity and 
also allows for our discussion to be open to 

anyone willing to take part in it.   
 

The following definitions are from Webster’s 

Unabridged Dictionary of the English 
Language, Random House, 2001. 

 
Observation – ―1. an act or instance 

of noticing or perceiving. 2 an act or 

instance of regarding attentively or 
watching.‖ 

 
The Scientific Method - ―a method 

of research in which a problem is 
identified, relevant data are 

gathered, a hypothesis is formulated 

from these data, and the hypothesis 
is empirically tested.‖ 

 
The Scientific Method is one of several ways 

in which scientific research is carried out 

and is covered in more detail in Chapter 1 of 
our lecture textbook.  The following is 

similar to the discussion of the Scientific 
Method in our text, but with some important 

topics added. 
 

 

Steps in the Scientific Method 
(There are no ―official‖ number of steps in 

the Scientific Method.  These steps do 
capture the spirit of the process though.)  

  
1. Observations 

An observation or a series of observations 

prompts someone to wonder and become 
inquisitive.  This leads the observer to make 

a claim about how the natural world works. 
  

2. Formation of a Hypothesis Statement  

A hypothesis is a statement (not a question) 
about how what was observed works.  It is 

tentative and needs to be tested.  Science is 
not concerned with being ―right‖ or ―wrong‖; 

but between what is ―true‖ or ―false‖.  So 
the hypothesis statement can be proven to 

be false.  Coming to the conclusion that a 

statement is false is an important aspect of 
science. 

 
3. Design of Experiment(s) 

Procedures for testing the hypothesis are 

developed.  These experiments will help to 
determine whether the hypothesis is true or 

false.   
 

4. Collection of Data 

Data are the specific measured observations 
made during the experiment. 

 
5. Analysis of Data 

Often the data needs to be mathematically 
and statistically analyzed to better 

understand the relationships between 

observations. 
 

6. Draw Conclusions from the Data 
Ultimately a conclusion must be drawn 

based on the data.  

 
7. Compare Conclusions to Initial Hypothesis 

The experimentally derived conclusion is 
then compared to the initial hypothesis. 

 
  Continued on the next page 
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8. Acceptance or Rejection of Hypothesis 

Lastly, the original tentative hypothesis is 

either accepted (it was found to be true) or 
rejected (it was found to be false). 

 
9. Communicate your Data and Results to 

the world.  

While not specifically a step in the Scientific 
Method, effectively communicating ―what 

you have done‖, ―how you did it‖, ―what you 
have observed‖, and ―what it means‖ is an 

important part of the process of science.  
You want others to share in your exploration 

of the natural world. 

  
10. Use the Observations (what you have 

learned) from the above process to form 
other Hypotheses and then start the above 

process again. 

 
The process of science is more circular than 

linear.  At what seems to be the ―end‖ of 
the process are observations that lead to 

further rounds of experimentation.  The 

process of science is also self-correcting.  A 
hypothesis that is found to be false has a 

very real value.  Understanding what is true 
and what is false allows us to better 

understand our world.   
 

As discussed above, Observations are the 

first step in the Scientific Method and are 
obviously used throughout the entire 

process.  Since Observations are 
fundamental to the overall process of 

science, Observations deserve some 

attention.  
 

Lab Activity 
This lab activity will allow you to practice 

both your observation skills and your 
communication skills. 

 

Materials needed: 
 A figure constructed of Lego blocks and 

a container of selected Lego blocks  
      (both provided by your instructor)  

 Pen  

 Paper  
 Clock (or time will be kept by your 

instructor) 
 

Procedure 
 

1.  Obtain a bag containing a figure constructed of 

Lego blocks from your instructor.  YOU WILL NOT 
TAKE IT APART AT ANY POINT DURING THIS 

ENTIRE LAB.  Record the number on your figure. 
The model should contain between 10-15 Legos (if it 

is too small, notify your instructor). 

 
2.  Examine the figure for two minutes, timed with a 

clock.  After two minutes, place the figure 
underneath a piece of paper where it cannot be 

seen. 
  

3.  Using any loose blocks necessary from the bag, 

attempt to exactly reconstruct the figure you 
examined in step 2.  DO NOT look at the original 

figure while reconstructing it. 
 

4.  Look at the original figure.  Compare the original 

to your reconstructed version.  Now take a moment 
and answer question 1 under ―follow up questions‖ 

on the last page of this activity.  Take apart your 
reconstructed version (DO NOT take apart the 

original figure) and put the blocks back in the 

container. 
 

5.  Examine the original figure again for 15-20 
minutes.  While examining it, use a pen and paper 

to write/draw instructions for its reconstruction.  
(Use the next page for this purpose).  If you 

wish, you may also have the container of Lego 

blocks to use when writing instructions.  You should 
not take apart the original figure. 

 
6.  After 15-20 minutes, put away the original figure, 

and give your written instructions and bag of Lego 

blocks to another student.  Have that student try to 
reconstruct the original figure using your directions 

and the container of blocks (but without having seen 
the original model). 

 
7.  Retrieve the original figure.  Compare the original 

to the version reconstructed with your instructions.  

How similar are the two figures?  Take apart the 
reconstructed version and put the blocks back in the 

container with the original model (make sure you do 
not mix up Legos from two different models!).   

 

 
Return the bag to your instructor in the same 

condition as when you received it. 
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Activity 1  Turn-in Sheets 
Observations, the Scientific Method, and Legos 

 
 

Observations / Instructions   (Use this space to write down your instructions in Step 5) 
 

You will pass this along to another group so they can reconstruct your model without seeing the actual 

model. 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 

 
 

 
You will be expected to record observations in all future lab experiments. 
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Follow-up Questions    
Write legibly.  Make responses clear and concise.  Make sure you address all parts of the 

question. 
 

1.  How similar was your reconstructed figure to the original in step 3?  If you were able to 
reconstruct it exactly, do you believe you would be able to reconstruct it tomorrow or a week 

from now without looking at the original figure or using notes? 
 

 

 
 

 
 

2. How does what you learned in this Lego activity apply to your actions during an experiment 

and while writing the procedure and observations in a lab report? 
 

 
 

 
 

 

 
3.  How much did the written instructions provided by another student help in constructing your 

figure?  Was the figure reconstructed by another student according to your instructions exactly 
the same as the original figure?  Some reconstructed figures do not turn out the same – how 

does this reflect on the accuracy and clarity of your instructions? How could you improve on your 

set of instructions? 
 

 
 

 

 
 

 
 

4.  What elements should and should not be included in a good set of instructions? 
 

 

 
 

 
 

 

5.  List two instances when clearly written instructions are necessary and used in everyday life. 
 

 
 

 
 

 

Fill this out after you have cleaned your station and before you ask your instructor to sign: 

Student Signature ____________________________          Date:________ 
            
Lab Partner’s Name ________________________Instructor’s initials _____ 
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Activity 2 
Graphical Analysis with 
Logger Pro 
 
Purpose 

 
Vernier’s Logger Pro® is a graphical analysis 

software that will allow you to collect, graph 

and manipulate data.  This lab will give you 
some practice using the program, especially 

since you will use it many times in your 
chemistry courses.   

 

 
 

Part 1: Linear Regression, Dependent 
and Independent Variables 

 
Linear regression analyzes how well two 

variables are related to each other by fitting 

a linear equation to the data. 
 

Sample data below show how the mass 
changes with volume of an unknown metal. 

 

Table 1.  Volume and mass measurements 
of an unknown metal 

 

Volume (ml) Mass (g) 

2.00 5.100 

3.10 8.900 

4.00 10.900 

5.30 13.800 

 

Here, the volume is displayed as the 
independent variable (assigned x-values) 

since the volume was manipulated 

approximately every 1 mL.  The mass is the 
dependent variable (assigned y-values) 

since mass was recorded in response to the 
change in volumes. 

 
 

 

 
 

 
 

 

 

Part 2: The Equation of a Line 

 
If there is a linear relationship between 

volume and mass, a graph will show that 
the data points look like they connect in a 

straight line (or nearly so). 

 
You can draw a straight line through the 

data, not by connecting the points, but by 
approximating a line that passes as near to 

as  
many of the points as possible.  This is 

called a ―best-fit‖ line.  The line doesn’t 

necessarily pass  
through any of the plotted points but it 

allows you to visualize the ―scatter‖ in the 
data. 

 

The equation of any straight line is: 
 

 y = mx + b   (1) 
 

Where y is the y-axis, x is the x-axis, m is 
the slope and b is the y-intercept (where the 

line crosses the y-axis). 

 
According to Table 1, you will graph grams 

as y and milliliters as x, so that equation 1 
above becomes 

 

 g = m * mL   (2) 
 

Rearranging (2) gives us the meaning of the 
slope: 

 

 m = g/mL    (3) 
 

(slope, m, equals density given in g/mL)   
 

In this case, the slope has a physical 
meaning. We can use the value of the slope 

as the density of the metal (Eqn 3) which 

will allow us to identify it later. 
 

Instead of drawing in the line by ―eye‖, 
Logger Pro will find the best-fit line using a 

least-squares method (from statistics).  You 

will also obtain the equation of the best-fit 
line as well as a correlation coefficient (R2) 

which gives you a value of 1 if the data 
perfectly fits a straight line.
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Part 3: Graphing in Logger Pro  
 

THE FOLLOWING PROCEDURE IS FOR 

LOGGER PRO.  
  

1. Open Logger Pro. An empty table and 
empty graph will be displayed. 

 

2.  Enter the data given in Table 1. 
 

3.  We don’t want the points connected. 
Click on the graph to select it, then choose 

the Options menu then Graph Options.  
Deselect ―connect points‖ and select ―point 

protectors‖. While you’re here, give the 

graph a title: Determining the density of an 
unknown metal.  Click done. 

 
4. It is important to use significant figures 

(as shown in Table 1) and to label our axes 

with units.  Right-click on the x-column and 
select Column Options and Data Set | X.  

Use the Column Definition tab to type in 
a name, short name, and units for the X-

column.  Then select the Options tab and 

under ―displayed precision‖ select decimal 
places. Select the number of decimal places 

that should be displayed for your x-values (2 
in this case).  Click done.  Repeat for y-

values.  When finished, check the table for 
significant figures. Check the graph for axes 

labels and correct units. 

 
5.  To perform the linear regression 

analysis, choose the Analyze menu then 
Linear Fit, or click the short-cut button  .  

A best-fit line will appear with the equation 

of the best-fit line. 
 

6.  Print a copy of the graph for EACH 
person in your group. Before you do, choose 

File>Page Setup>Orientation:Landscape.  
Click OK.  Then click File>Print. Check Print 

Footer and type in your name. Click OK. 

 
 

 
 

 

 
 

 
 

Part 4: More graphing 
 

Below is another set of data for you to try 

graphing.  Follow the directions in Part 3 to 
graph these data.  Then obtain an equation 

that relates Celsius to Fahrenheit.  Don’t 
forget to print enough copies for everyone 

in your group. 

 
 

Table 2.  Temperature readings in units of 
Celsius and the corresponding measurement in 

Fahrenheit. 
 

Temperature (ºC) Temperature (ºF) 

0.0 37.0 

10.1 47.0 

20.0 71.5 

30.2 88.4 

40.0 101.2 

50.1 125.0 
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Activity 2 Turn-in Sheets 
Graphical Analysis with Logger Pro 

 
Follow-up Questions 

 
Using your density graph (from Part 3): 

1)  Using your graph and without doing any calculations, show on the front of your graph how 
you can estimate the volume for a 4.50-g mass of this unknown metal. (Do this by drawing a line 

from 4.50-g on the y-axis to the best-fit line, then from that point on the line to the x-axis.)   
 

What is your estimated value for volume? ________________ mL 

 
 

2)  What is the equation of the line you obtained?  Write it out in the form y=mx+b.  
 

 

How good is the correlation (Give a value from -1 to 1, shown on your graph)?   
 

 
3)  Using the equation displayed on your graph, calculate the volume for a 4.50-g mass of the 

unknown metal.  Show your work below. 
 

 

 
 

 
 

4)  Use the table below to identify the metal based on the information obtained from your graph. 

Explain how you chose the metal’s identity. 
 

 
 

 

 
 

 
 

 
 

5)  How does your metal’s density compare to that in the table above?  Scientists usually 

calculate a % error to compare their values with standard values.  
 

100%  
accepted

 accepted - alexperiment
  error   % ³=

 
To calculate % error for this lab, use your slope as the experimental value and the density from 
the chart as the accepted value.  Show your work. 

 
 

 

 

Substance Density (g/mL) 

Magnesium 1.74 

Aluminum 2.70 

Titanium 4.50 

Iron 7.86 

Copper 8.93 

Gold 19.32 
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Using your temperature graph (from Part 4): 

 

6)  Looking at the data in Table 2, which appears to be the independent variable, C or °F?  

Explain.  On which axis should the independent variable be graphed? 
 

 
 

 

 
 

7)  What is the equation of the line you obtained?  How good is the correlation? 
 

 

 
 

8)  The accepted conversion for Fahrenheit to Celsius is given by the following equation: 
 

°C = 5/9 (°F – 32)   (4) 

 
Rearrange the equation to solve for °F, then compare this with the equation you obtained from 

the graph.  Compare the slope from Equation 4 above to the slope you obtained on your graph.  
Calculate a percent error. 

 
 

 

 
 

 
 

9)  Absolute zero is at -273°C.  Use the equation you obtained from your graph to find this value 

in degrees Fahrenheit. 
 

 
 

 
 

 

 
10) BONUS: There is a temperature that is the same in Celsius as in Fahrenheit.  Can you figure 

it out using Equation 4?  Show your work. 
 

 

 
 

 
 

 

 
 

Make sure your name is on the front of your graph before you turn it in.  Sign and 
date your graphs.

Student Signature ____________________________          Date:________ 
            
Lab Partner’s Name ________________________Instructor’s initials _____ 
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Activity 3 
Scientific Measurements: Precision and Accuracy 
  
Background 

 

Precision and accuracy are terms that are 
often used interchangeably, but they have 

very different meanings.  Accuracy is a 
measure of the correctness of a 
measurement.  For example, you might 
calculate the density of a piece of zinc to be 

7.27 g/ml, but in actuality zinc has a density 

of 7.14 g/ml.  Another student in the class 
may calculate the density of zinc to be 6.56 

g/ml.  Since your answer is closer to the 
agreed upon value, your measurement is 

more accurate.  Often there is no ―true‖ 

value to compare to in an experiment as we 
had above and therefore you cannot 

comment on a measurement’s accuracy.  On 
the other hand, you can comment on 

precision every time you take a series of 
measurements. 

 
Precision is a measure of the reproducibility 
of a measurement.  Imagine you repeated 

the zinc density experiment a second time 
and this time measured a value of 7.26 

g/ml.  Your value is very close to your first 

experiment.  You could say that your 
precision is quite good.   

 
Precision also deals with the closeness or 

fineness with which a measurement may be 

made.  What does that mean?  Think about 
measuring your weight.  If you measure 

your weight at home on your bathroom 
scale, you may get a reading of 135.5 lbs.  

At a doctor’s office that day the nurse 
measures your weight to be 135.39 lbs.  

The scale at the doctor’s office has a higher 

precision than the one you have at home. 
The limited precision creates uncertainty 

which restricts the conclusions that can be 
made from the measurement.  Scientists 

represent this precision in the equipment by 

putting writing ―± error‖ after the 
measurement.  For example, the first scale’s 

measurement would be written as 135.5 ± 
0.1 lb.  This shows that there is an 

uncertainty in the last digit of the 
measurement.  The doctor’s scale  

 

 

measurement would be written as 135.39 ± 
0.01 lb.  Keeping track of the uncertainty of 

each piece of equipment could be painful.  
Scientists use significant figures (sig figs) to 

indicate the precision without having to 
keep track of which pieces of equipment 

were used to make all the measurements. 

 
Significant figures include all the known 

values of a measurement plus one guess.  
Let’s go back to the scale example.  When 

you stand on the bathroom scale, the 

needle might point between 135 lb and 136 
lb (as in figure 1 below). You know that you 

weigh more than 135 lb but less than 136 
lb.  The correct way to report this value is to 

report the known values (135) plus a guess 
(135.4  the 4 is the guess).   

 

In general,   

Estimate the value to one 
decimal place more than the 

level of graduation. 
 

In the example above, the graduation is 

every 1 lb. Therefore, the measurement is 
reported to the 0.1 lb (135.4 lb, which has 

one decimal place). 
 

 
 

 

 
 

 
 

 

 
 

 
 

 
 

Figure 1 – Scale showing a mass 
between 135 and 136 lb.  Note the 
lack of markings between 135 and 
136. 

135 136 
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Every measurement you take must include 

the proper number of significant figures!!  
You can determine this by looking at the 

graduations on your device.  Don’t be afraid 
to guess at the last value.  The last digit is 

uncertain.  Many students ask if significant 

figures are important.  Read the following 
fable and then draw your own conclusions: 

 

Are Significant Figures Important?  

A Fable 

 

A student once needed a cube of metal 
which had to have a mass of 83 grams. He 
knew the density of this metal was 8.67 

g/mL, which told him the cube's volume. 

Believing significant figures were invented 
just to make life difficult for chemistry 

students and had no practical use in the real 
world, he calculated the volume of the cube 

as 9.573 mL. He thus determined that the 
edge of the cube had to be 2.097 cm. He 

took his plans to the machine shop where 

his friend had the same type of work done 
the previous year. The shop foreman said, 

"Yes, we can make this according to your 
specifications - but it will be expensive." 

"That's OK," replied the student. "It's 
important." He knew his friend has paid $35, 

and he had been given $50 out of the 
school's research budget to get the job 

done. 

He returned the next day, expecting the job 

to be done. "Sorry," said the foreman. 
"We're still working on it. Try next week." 

Finally the day came, and our friend got his 

cube. It looked very, very smooth and shiny 
and beautiful in its velvet case. Seeing it, 

our hero had a premonition of disaster and 
became a bit nervous. But he summoned up 

enough courage to ask for the bill. "$500, 

and cheap at the price. We had a terrific job 
getting it right -- had to make three before 

we got one right." 

 

"But--but--my friend paid only $35 for the 

same thing!" 

"No. He wanted a cube 2.1 cm on an edge, 

and your specifications called for 2.097. We 
had yours roughed out to 2.1 that very 

afternoon, but it was the precision grinding 
and lapping to get it down to 2.097 which 

took so long and cost the big money. The 
first one we made was 2.089 on one edge 

when we got finshed, so we had to scrap it. 

The second was closer, but still not what 
you specified. That's why the three tries." 

"Oh!"
2 

 
 
So, what do you think? Are sig figs 

important for communicating information 
about precision? 

 

 
 

 
 

Purpose 

The purpose of this activity is to get familiar 
with the approximate precision of the 

equipment in your laboratory.  You will 
practice how to record measurements with 

an appropriate number of significant figures. 
 

 

 
 

 

                                                 
2http://dbhs.wvusd.k12.ca.us/webdocs/SigFigs/SigFigsF
able.html 

 

http://dbhs.wvusd.k12.ca.us/webdocs/SigFigs/SigFigsFable.html
http://dbhs.wvusd.k12.ca.us/webdocs/SigFigs/SigFigsFable.html
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Activity 3  Turn-in Sheets 
Scientific Measurements: Precision and Accuracy 
 
You will be graded on the number of 

digits used, the presence of units on 
your measurements, and explanations. 

 

Use a pen to record all 
measurements!!! 

 

1)  Take out a 10-ml graduated cylinder.   

 
Check to see whether your graduated 

cylinder is calibrated to every 0.1 mL or 
every 0.2 mL. 

 

 My 10-mL cylinder is calibrated  

 to every ______ mL. 

Since the graduations are every tenth (or 

two tenths) you should try to report your 
volume to two decimal places.  If your 

graduated cylinder has 0.2 mL graduations, 

use the following example to estimate the 
second decimal place: 

 

 
 

With certainty, you can see the  
liquid is slightly above 6.6 mL.  

The bottom of the meniscus sits  
just above 6.6 mL.  

Let’s approximate that the liquid is  

1/10 (0.1) of the distance between  
the graduations 6.6 and 6.8 mL.   

Since each graduation is 0.2 mL, 
0.1 x 0.2 mL = 0.02 mL.  

Add this to your certain digits:  

6.6 mL + 0.02 mL = 6.62 mL. 
6.62 mL should be recorded.3 

                                                 
3
http://jchemed.chem.wisc.edu/JCESoft/Programs/ 

VideoCD/CPL/Sample/Modules/gradcyl/grad10mL.htm 

 
 

 
 

 

 
 

 
Place about 5-6 ml of water into your 10-mL 

cylinder and make a sketch of it below, with 

at least two labeled graduations (as in 
the previous drawing).  Be as accurate in 

your drawing as possible. 
 

 
 

Report your measurement with the correct 

number of significant figures here 
(Don’t forget units!): 

        ________________   
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2)  Now find a small plastic ruler and measure your pencil in cm and mm.   
 

Length (cm) = ______________________ 

 
Length (mm) = ______________________ 

 
Make sure the number of significant figures are the same whether you measure in cm or mm. 

 
Obtain a meter stick and record the length in meters.   

 

Length (m) = ______________________ 
 

Does your measurement have a different precision when you use a meter stick?  Explain.   
 

___________________________________________________________________________ 

 
___________________________________________________________________________ 

 

3)  Obtain a penny.  Use the balance to measure the mass of the weight.  With a digital balance, 

always record every digit the balance displays.  Record units. 
 

Mass _________________ 
 

Now measure several other pennies and note their masses.  Based on your observations, how 

many decimal places does this balance report?   
 

___________________________________________________________________________ 
 

___________________________________________________________________________ 
 

4)  If you measured the mass of an object on the balance from question 3 and got a reading of 
120.1 g would this be correct?  No, your balance measures more sig figs than that.  The 

balance just doesn’t show trailing zeros like it should.  Always report the correct sig figs 
despite the fact that the balance doesn’t always show the zeros at then end. Always include 

units. 

 
Correctly reported mass should be  = __________ g  instead of 120.1 g 

 
 

Is there a difference in reporting 120.1 g versus 120.10 g?  Why is it important to record the 

correct number of decimal places (how does the meaning of the measurement change)?  
 

___________________________________________________________________________ 
 

___________________________________________________________________________ 

 
___________________________________________________________________________ 
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5)  Take out a 50-ml beaker and add approximately 10 ml of water.      
Measure the volume of this water and record it below.   

How many significant figures can you report based on the graduations?   

Which digit contains the uncertain value?  Circle the digit that was estimated. 
 

 
  _______________ mL 

 
 

6)  Suppose a 10-mL pipet has an uncertainty of about ± 0.01 mL.  If it is filled with to the mark 
(10-mL), the volume should be reported as (include the necessary decimal places): 

 
 

  _______________ mL 

 
 

7)  What is the uncertainty of a beaker?  Let’s find out! 
 

Obtain a 250-mL beaker and pour somewhere between 50-75 mL of tap water into it, using 
the graduations on the beaker to approximate the volumes. 

 
With your lab partner(s), estimate the volume of water in the beaker and assign a ± value to 

estimate how uncertain you FEEL about the measurement.  Do this twice (one for each of 

you) and record your guesses below. 
 

 
__________ mL  ± _______ mL   __________ mL  ± _______ mL 

 

 
Now think of a way you can check your estimate.  Briefly describe your method below.   

 
___________________________________________________________________________ 

 
___________________________________________________________________________ 

 

___________________________________________________________________________ 
 

This is the value we report after verification:  __________ mL  ± _______ mL 
 

 

8)  How do we add measurements together using significant figures?  Let’s find out!4 
 
A)  Fill a 250-mL beaker with about 110-mL of water.  Fill a 100-mL graduated cylinder with 

about 65-mL of water.  Measure and record both below, keeping in mind how many 

digits you are permitted to record (remember, what you learned up until now!?!? See #7 
above.) 

 
The beaker contains __________ mL  and the graduated cylinder contains __________ mL 

 

Addition of these two numbers (keeping all decimal places) = _____________ mL 

                                                 
4 Abel, K.B.; Hemmerlin, W.M. J. Chem. Educ. 1990, 67, 213. 
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B) Do you think your total in Part A (including all the decimal places) is an accurate way to 

record the total volume of both pieces of glassware?  If not, suggest a better method to 
obtain an accurate total volume.  

 
___________________________________________________________________________ 

 

___________________________________________________________________________ 
 

___________________________________________________________________________ 
 

 

C) Now physically add the volumes together by pouring the contents of the graduated 
cylinder into the beaker.  Record a total volume, using an appropriate number of 

significant figures for a beaker. 
 

Addition of these two volumes (using significant figures) = _____________ mL 
 

 

D) Although your total volume in Part A contained more digits, your total in Part C is a more 
accurate way of recording the total volume.  Explain why. 

 
___________________________________________________________________________ 

 

___________________________________________________________________________ 
 

___________________________________________________________________________ 
 

  

 

9)  Given a choice, which glassware would you use to measure volumes more precisely, a 
graduated cylinder or a beaker?  Explain. 

 

___________________________________________________________________________ 
 

___________________________________________________________________________ 
 

 

10) Many times you’ll come across a new piece of lab equipment and need to determine its 
precision.  What would you look at to determine the precision of a piece of glassware? 

 

___________________________________________________________________________ 
 

___________________________________________________________________________ 

 
 

 
When finished, clean up. 

***Go back and check all of your measurements. Did you include units? 

 
 

Fill this out after you have cleaned your station and before you ask your instructor to sign:

Student Signature ____________________________          Date:________ 
            
Lab Partner’s Name ________________________Instructor’s initials _____ 
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Pre-Lab AssignmentðTo be completed BEFORE lab! 
For more information and a review on measurements and significant figures, try reading the 

section on significant figures in the Appendix in your textbook.  To answer the following 
questions, make sure you have read the BACKGROUND section of this lab!!! 

 
 

1) a)  Provide a measurement for each of the following pieces of glassware filled to the level 

indicated by the arrow.  Use the correct number of significant figures in your answer.  
Always use units. 

  
 

 
 

  

 
 

 
 

 

 
 

 
 

    ________      ________     ________ 

 
 

b)  Which gives the most precision, the graduated cylinder (a), the buret (b), or the beaker 
(c)?  How can you tell by simply looking at the glassware? 

 
 

 

 
2) A student performed an analysis of a sample for its calcium content and got the following 

results.   
 

14.92 g  14.91 g  14.88 g  14.92 g 

 
 (The actual amount of calcium in the sample is 20.90 g) 

  
 How accurate are the student’s results?  How precise are the results?  Explain briefly. 

 
 

 

 
3) On the back of this sheet, sketch two pieces of glassware: one that can report volume 

to the thousandths place and one that can report volume only to the ones place. 
(―Report‖ means to record the digits including your estimation.)   

 

HINT: A common mistake is to draw devices graduated to the thousandths or ones 
place—don’t do this! 

 
 

mL mL 

mL 

10 

11 
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Experiment 1 
The Floating Egg Problem 
 
 
The following problem is designed to further 

exercise your procedure writing skills and to 
introduce you to scientific inquiry. 

 

Background 

 

Chemists use special volumetric glassware in 
the chemistry laboratory (rather than the 

ordinary beakers and flasks) when they 
need high-precision measurements of the 

volumes of liquids.  Understanding the 

proper use and limitations of such glassware 
is important in achieving reliable results.  

Experimental technique and the inherent 
accuracy of the glassware both affect 

experimental results.  One of your personal 

goals for this course is to develop sound 
experimental techniques. 

 
In this experiment you will practice using 

glassware to improve your technique and to 
solve an important historical problem in 

practical chemistry.   

 
 

Historical Background  
 

―For many years soap was made at home 

from a variety of recipes.  Animal fat, 
usually from cattle (also called tallow) was 

cooked with a lye solution.  Lye, though it 
was mostly simple sodium hydroxide, could 

not be made from purified chemicals, as we 

do now.  Instead, the solution was obtained 
from ashes and water.  The ashes were 

treated with hot water, and then the 
mixture was filtered to obtain a solution.   

 
But before this could be used in soap 

making, one had to check the concentration 

of the lye solution.  One simple test was to 
try to float a raw egg in the solution.  If the 

egg sank, the concentration of the lye in the 
solution was too low.  If the egg floated too 

high, the concentration of the solution was 

too great, and water was added before 
adding the fat.  To ―just float‖ in this case  

 

 

 
 

 
 

means to make the top of the egg just 

touch the top of the solution, without any 
significant amount of the egg protruding 

above the surface of the solution.‖5 Because 
lye is caustic and corrosive, sodium chloride 

will be substituted in this lab.  The solutions 
are concentrated enough to be an eye 

hazard so safety goggles must be worn.   

 
 

Purpose 
 

You are to determine the density (in grams 

per milliliter) of the salt solution to ―just 
float‖ an egg.   

 
The goal of the experiment(s) we will be 

doing is to become directly involved in 
scientific inquiry.  Gaining first-hand 

knowledge of the processes of scientific 

inquiry, problem solving, and critical thinking 
is of equal or greater importance than 

knowing the ―correct‖ answers to problems.  
Often, problems do not have a single correct 

answer; there may be several possible 

solutions. So, understanding the process of 
science allows us the ability to address a 

variety of problems now and in the future.        
 

 

Materials Available 
Deionized water 

Lab Station Supplies 
Balances 

Eggs 
Sodium chloride (salt) 

Volumetric flasks 

 
 

 
 

 

                                                 
5
 Adapted from ―Working with Chemistry A Laboratory 
Inquiry Program‖ by Donald J. Wink, Sharon Fetzer 
Gislason and Julie Ellefson Kuehn; W.H. Freeman and 
Company New York, 2000. 
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Experiment 1  Turn-in sheets 
The Floating Egg Problem 

 
Before you begin, complete the following with your lab partner: 
 

1.  Rephrase the purpose of this experiment (in one sentence, what are you trying to 
accomplish?) 

 

 
 

 
 

 

 
 

2.  Formulate a procedure for this experiment.  Write down your procedure clearly enough that 
other people will be able to reproduce your experiment.  Use the space below. 

 
 

*BE very specific in which equipment you intend to use for your measurements (e.g. 50-mL 

beaker or 10-mL graduated cylinder, etc…) as this will affect your precision. 
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Data  
This page is to keep track of your observations, data, and to record any changes you may have 

made to your original procedure. Try to make this page as neat as possible, without re-writing 
your data after the experiment. It is expected that it will not be perfect—but please make it 

legible.  Remember, your work must be understood by others who read it. 
 

If you absolutely must start over, use the next page or a blank sheet provided at the back of this 

manual. 
 

Always use PEN to record data. Record units for all measurements! 
If you make mistakes, do not use white-out.  Do not rewrite this page. 
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Results and Calculations 
Summarize your data from the previous page in a concise fashion (you may wish to put the data 

in a data table).  What do you conclude from the data to answer the question posed in this 
experiment?  Show your calculations, using an appropriate number of significant figures. 

Remember, your work must be understood by others who read it. 
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Follow-up Questions 

1.  According to your calculations, what is the density of the solution in which the egg just 
floated?   

 

2.   a)  How does this compare to the value determined by other groups?  Find at least three 
other groups and record their values below. 

 
 

 
 b)  What factors do you think contributed to the variation in density values in the class? 

 

 
 

  
 

 

3.  Is there anything you would change about your procedure now that you have completed the 
lab?   

 
 

 
 

 

 
 

 
4.  Consider the glassware you used to measure the density of the salt solution.  What glassware 

did you use to record your volumes (if you used volume measurements), and how could this 

influence the accuracy and precision of your results?  Was there a better choice in glassware that 
would have increased your accuracy and precision? 

 
 

 
 

 

 
 

5.  The concentration of the salt solution is different from the density of the salt solution and can 
be obtained by taking the mass of salt used (in grams) and dividing it by the total volume of 

solution (in mL) and multiplying by 100 to get a percent by mass-volume.  If you have these 

data, calculate the concentration as % (m/v) of your salt solution. 
 

 
 

 
 

 

Student Signature ____________________________          Date:________ 
            
Lab Partner’s Name ________________________Instructor’s initials _____ 
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Pre-Lab AssignmentðTo be completed BEFORE lab! 
Understanding Activity 3 in this manual and significant figures and uncertainty in measurements 

in general will help you answer the last two questions. 
 

1.  In your own words, what is the purpose of this experiment? 
 

 

 
 

 
 

2.  Briefly outline a procedure for the experiment you will carry out in lab. 
 

 

 
 

 
 

 

 
 

 
 

 

 
 

3.  The density of a liquid is determined using a 50.00 mL volumetric flask (which has an 
uncertainty of ±0.01 mL).  Would the reported density value be exactly the same if a 600-mL 

beaker (which has an uncertainty of ±10 mL) was used for the volume measurement?  Explain 
how the reported values would be different and which would be preferred. 

 

 
 

 
 

 

 
 

 
 

 
4.  What kinds of limitations will you encounter in the precision of your density measurement(s)?  

What will you do (or use) in your lab procedure to ensure the highest level of precision possible?
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